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Switched-On Schoolhouse 2008 School Edition (SOS) Admin, Teacher, and Student are all easy to install on your  

computer. Before inserting the installation disc, check to make sure your computer meets the recommended minimum system 

requirements, ensuring that the program will run at its best.  

Recommended Minimum System Requirements for the Server

The recommended minimum system requirements for the server are: 

n	2.4 GHz single core (or 1.6 GHz dual core) or better processor

n	512 MB RAM (1 GB is recommended)

n	2 — 120 GB mirrored hard drives

n	Windows® 2003 Server or Windows® Server 2008 operating system

n	CD-ROM or DVD ROM drive

n	 USB 1.1 port (USB 2.0 recommended)

n	10/100 MHz Ethernet interface card

n	Super VGA (1,024x768) or higher resolution video adapter and monitor 

n	�Backup capability with tape drive, CD-RW DVD, or external USB or or FireWire hard drive

Recommended Minimum System Requirements for the Client Computer

Requirements 
XP Service Pack 2 Vista (all versions)
Minimum Requirements
•   	Microsoft IE 6 or higher
•	   500 MHz or higher processor
•   	512 MB Memory (RAM)
•	   600 MB hard drive space
•	   �1024 X 768 or higher resolution moni-

tor, 16 bit color
•   	CD-ROM drive
•	   Adobe Acrobat Reader
•	   Printer recommended

Minimum Requirements
•	   Microsoft IE 7 or higher
•   	1 GHz or higher processor
•	   1 GB Memory (RAM)
•   	600 MB hard drive space
•   	�1024 X 768 or higher resolution moni-

tor, 16 bit color
•	   CD-ROM drive
•	   Adobe Acrobat Reader
•   	Printer recommended

For optimal performance:
•   	Microsoft IE 6 or higher
•	   1 GHz or higher processor
•	   512 MB Memory (RAM)
•	   600 MB hard drive space
•	   �1024 X 768 or higher resolution moni-

tor, 16 bit color
•   	CD-ROM drive
•	   Adobe Acrobat Reader
•	   Printer recommended

For optimal performance:
•	   Microsoft IE 7 or higher
•	   1.5 GHz or higher processor
•	   2 GB Memory (RAM)
•   	600 MB hard drive space
•	   �1024 X 768 or higher resolution moni-

tor, 16 bit color
•	   CD-ROM drive
•	   Adobe Acrobat Reader
•   	Printer recommended

The requirements listed above are minimal.  Depending on your computer’s configuration, you may 

find it more beneficial to use Switched-On Schoolhouse® 2008 School Edition on a computer  

exceeding the above requirements (i.e., faster processor speed and more memory).  A printer is also 

highly recommended.

We do not support a 64 bit operating system.
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Overview of the Installation Process

In setting up your school, you will be installing SOS in two ways, a server installation and client installations. 

1.	 �Server Installation:  A single server computer will host most of the components of SOS.  These include:

	 n	 your school’s SOS database, which houses school, teacher, class, and student records;

	 n	 �the synchronization and/or remote servers necessary to set up a distance learning program (optional);

	 n	 the curriculum files;

	 n	 �SOS Admin, Teacher, and Student applications. Once these applications are available on the server, you can 

then choose to use the network to download the Teacher and Student applications to other (client) computers 

or have them available on the server as resource and backup. 

2.	� Client Installation:  Multiple client computers act as individual workstations for the administrator, teachers, and stu-

dents in your SOS school. Each client computer accesses the information it needs from the SOS server  

database over a network. Most client computers only have SOS Student installed.  Others are SOS Teacher and/or Admin 

workstations, depending on your network configuration.  You have the option to load SOS Admin, Teacher and Student 

on any client computer.

This section of the guide walks you through the installation steps for both server and the client computers.

SOS curriculum files are delivered to you on an external USB hard drive.  We highly recommend  

installing the curriculum files to a hard drive in the server. The curriculum files take about 60 GB of 

hard drive storage space. You may utilize the curriculum files from the external USB hard drive, but this 

may lead to performance issues when using the SOS application.

Server Setup:

The Server setup process includes these four basic steps:

	 1.  Create a Shared Folder — Create a shared folder on the server for the curriculum files.

	 2.	 Database Setup — There are two options for installing the SOS database:

		  a.  Install both Microsoft SQL Database and the SOS database to run under Microsoft SQL.

		  b.  Install the SOS database only; you already have Microsoft SQL server installed.

	 3.  Application Setup — Install all three applications on the server.  This is the default setup.

	 4.  �Copy Curriculum Files — Copy the curriculum files from the external hard drive to the shared curriculum folder on the 

server.

Client Computer Setup:

There are two choices for client installation. 

1.	� Client Installation over the Network — (Recommended) Create a shared folder on the server and install the  SOS 

applications to each computer over the network.  See the step-by-step instructions on page 32—33.

	2.	 Client Installation from disc — Install the SOS application to each computer with the installation disc.

Items needed for Installation

Please make sure you have the following items available before beginning to install SOS:

n	Installation disc

n	Curriculum Hard Drive

n	Product and License Keys
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Create the Shared Curriculum Folder

The following procedure is used to create a shared folder for the curriculum files from the external USB curriculum drive to be 

copied in a later step of server setup. You need to create the shared folder in a location that has a minimum of 61 GB of free 

drive space. A shared folder is created on the local drive. The location of the shared folder may vary for your installation.

Step 1: 	 Open My Computer.

Step 2:	 Click the Local Disk (C:).

Step 3:	 Click File, then on New, and then on Folder.

Step 4:	 Name the folder 2008_Curriculum or Subjects08, or something similar.

Step 5:	 Right-click the new folder and select Sharing (Sharing and Security).

Step 6:	 Click the option Share this folder.

Step 7:	 Click the Permissions button.

Step 8:	� In the Permissions window, uncheck Full Control and Change. The Read Only option remains checked.

Step 9:	 Click the Apply button, then click the OK button.

Step 10:	 Click the Apply button, then click the OK Button and close the Properties window.

Your Shared Curriculum Folder is now ready to use. Later, in the server setup, you will see how to copy curriculum files from the 

external USB hard drive to the Shared Curriculum Folder. Next, complete the Database Setup phase.

SOS 2008 Setup

Install Microsoft® SQL & Local Database

Any time you install multiple services (web, applications, etc.) there is a possibility that one of them may experience  

problems. Best practices indicate that these services be installed on separate servers to minimize the risk of one corrupted ser-

vice affecting others. As you decide where to install your SQL Server, we recommend you consider the following:

•	 Whenever possible, do not install SQL Server on a domain controller. 

•	 Run separate SQL Server services under separate Windows accounts. 

•	 In a multitier environment, run Web logic and business logic on separate computers. 

 �During the SOS 2008 install, your computer may restart several times.  To prevent loss of data, it is 

highly recommended you close all other applications during the installation process.

If you have previously installed SQL Server, go directly to Local Database Only on page 29. You do not 

need to install Microsoft® SQL.

To install both Microsoft® SQL and a local database, follow these steps:

Step 1: 	� Insert the Switched-On Schoolhouse® 2008 School Edition (SOS)  

disc into your CD-ROM drive. When the disc is inserted, the SOS 

2008 Setup window, shown on the next page, displays. If the  

SOS 2008 Setup window does not display, then go to Start,  

Run, and type D:\MainSetup.exe. This assumes that your  

CD-ROM drive with the installation disc in it is the D drive.
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Step 2: 	� Click the first option, Install Microsoft® SQL & Local 

Database. The SOS 2008 Installed Products window  

displays. This window, similar to the one shown below,  

indicates which of the required components are already  

installed and which need to be installed before installing  

the SOS application.

Step 3: 	� Click the Install button.  A small Confirm Installation  

pop-up box, similar to the one shown below, displays, indicating which programs will be installed.

Immediately after you click OK (on the Confirm Installation pop-up box), the first  

needed component begins installing automatically.  The components that are  

required to run SOS include:

	 •	 Microsoft® Windows Installer 3.1

	 •	 Microsoft® .NET Framework 2.0

	 •	 SOS 2008 SQL 2005 Express Server

SWITCHED-ON schoolhouse® 2008 SCHOOL edition server  

database 

When all of the required components are finished installing, the SOS 2008  

Setup window displays again. Now it is time  to install the School Edition  

Server Database.  While it does not install automatically, it does contain a  

Setup Wizard, which walks you though the installation step by step.   

Step 4: 	� Click OK.  The AOP Setup Wizard screen displays.

Step 5:	 Click Next. The Destination Folder screen displays:



24

Step 6: 	� Click Next.  The Migrate 2007 SOS School Database  

screen displays:

At this point you are given the opportunity to migrate the  

existing SOS 2007 version database.  If you choose to  

migrate, continue with Step 7; otherwise, proceed to Step 9.

Step 7: 	� Click the box next to Migrate to migrate a database.   

Specify the School Edition Server Instance either by  

typing in the Server Instance–(local)\SOSSCHOOL22 or by  

using the drop-down arrow.  Select Use default sa  

password.  

Step 8:	 Click Next. Skip to Step 10.

	� Depending on the size of the database being migrated,  

the time required may be a few minutes to considerably  

longer.  During this process, little activity is visible.  Please  

be patient and do not interrupt the migration process.

Step 9: 	� The Setup Admin Account screen displays.  Type your  

Admin password in both the Admin Password and  

Confirm Password textboxes.

Step 10: 	� Click Next. The Ready to Install the Program screen  

displays.
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Step 11: 	� Click Install.  The Setup Wizard begins installing Switched- 

On School 2008 School Edition Server Database.  This  

process may take up to several minutes.  After the Server  

Database is installed, the AOP Setup Wizard Completed  

screen displays:

Step 12: 	� Click Finish.  The Installation Complete pop-up box displays:

Step 13: 	� Click OK.  A new  SOS 2008 Setup window displays, with  

checkmarks next to all installed applications:

Step 14: 	� This completes the Microsoft® SQL and Local Database  

setup.  Click Close.  The SOS 2008 Setup window displays  

again.  Continue to the next section, Admin, Teacher, &  

Student.

Admin, Teacher, & Student

After your database has been installed, you need to install the SOS Admin, SOS Teacher, and SOS Student applications.   

To install these applications:

Step 1: 	� On the SOS 2008 Setup window, click the second option,  

Admin, Teacher, & Student.
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Step 2: 	� The SOS 2008 Installed Products window displays.  

This window, indicates which of the required  

components are already installed and which need to  

be installed before the SOS applications are installed.

Step 3: 	� Click the Install button.  A small Confirm Installation  

pop-up box, displays, indicating which applications  

(components) will be installed.

Step 4: 	 Click OK. 

Immediately after you click OK (on the Confirm Installation pop-up box), the  

first needed component begins installing automatically.  The components 

required to run SOS include:

	 •	 Microsoft® Windows installer 3.1

	 •	 Microsoft® .NET Framework 2.0

	 •	 Microsoft® .NET Framework 3.0

	 •	 Adobe Flash™ Player 9 / Adobe Shockwave™ 10

	 •	 Crystal Reports for .NET Framework 2.0

Switched-On Schoolhouse® 2008 SCHOOL EDITION 

These first components are automatically installed. While Switched-On Schoolhouse® 2008 School Edition (SOS) does not auto-

matically install,  it does contain a Setup Wizard, to walk you though the installation process step by step.   

Step 1: 	� The AOP Setup Wizard screen displays as soon as your  

computer finishes installing the last of the required  

components. Click Next.
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Step 2: 	� The License Agreement displays. Click next to “I agree.”

Step 3: 	 Click Next.  

Step 4: 	 The Destination Folder screen displays.  Click Next. 

Step 5: 	� The Custom Setup screen displays. Click Help if you do not  

wish to install all three features. The Custom Setup Tips  

screen (shown below right) displays, allowing you to  

customize what you install.

Step 6: 	� Determine which features you want to install, and click OK  

to return to the Custom Setup screen; then click the down  

arrow next to the features you do not wish to install:
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Step7: 	� Click Next to install all the chosen applications:  SOS Admin,  

SOS Student, and SOS Teacher on your computer.  

Step 8: 	� The Database Server window displays. Use the SQL Server  

Instance drop-down menu on this window to locate your  

SQL Server Instance, or type the name in manually in the  

blank textbox, such as Server_Name\SOSSCHOOL30 for  

an SQL Express installation.  If using full SQL, then just enter  

the Server_Name.

Step 9: 	� Enter the sa (system administrator) password you set up  

during the SQL Server installation.

Step 10: 	 Click Next. 

Step 11: 	� The Curriculum Location screen displays. Click Next to  

proceed or click Change to browse to your hard drive or  

type in the location of your shared curriculum folder. 

For example, enter server_name\c:\subjects08, where  

“server_name” is the actual name of the server containing  

your curriculum, and “subjects08” is the name of the shared 

curriculum folder.

Step 12: 	� The Ready to Install the Program screen displays.  

Click Install.  
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Step 13: 	� The AOP Setup Wizard Completed screen displays after  

all of your new files are copied. Click Finish. 

		�  This could take several minutes. Please wait for the  

installation to complete. 

Step 14: 	�   The Installation Complete pop-up box displays  

Click OK. :

Step 15:    �Click OK.  A new SOS 2008 Setup window displays, with  

checkmarks next to all installed applications 

Step 16: 	� Click Close. Icons for each of the features (SOS Admin, 

SOS Teacher, and SOS Student) you installed are added  

to your computer’s desktop. 

Step 16: 	 Click Close again on the SOS 2008 Setup screen.

Local Database Only

Use this option only if you have an existing installation of SQL Server 2003 or SQL Server 2008.

To install a local database only, follow these steps:

Step 1: 	� Click the last option, Local Database Only on the SOS 2008 Setup  

window.  The Installed Products screen appears, listing all of the  

components required to install the database. Already installed items  

have a checkmark next to them. Unchecked items will be installed.

Step 2: 	�  Click Next. When all items except the SOS database are installed,  

the AOP Setup Wizard screen displays. This wizard opens and walks  

you through the installation process for the SOS 2008 database.

Required components include:

	 •	 Microsoft® Windows Installer 3.1

	 •	 Microsoft® .NET Framework 2.0

	 •	 MSXML 6.0 Parser

	 •	 Microsoft® Server Native Client

	 •	 Microsoft® SQL Server Management Ojects Collection 

	 •	 Switched-On Schoolhouse 2008 - School Edition Database
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Step 2: 	 Click Next.  

Step 3: 	� The Destination Folder screen displays: 

Click Next, indicating you want to install Switched-On  

Schoolhouse® 2008 School Edition in the location  

displayed.

Click Change to go to the Change Current Destination  

Folder screen if you want to install to a different folder.   

Click OK when finished.

Step 4: 	� The Database Server screen displays next.  

Use the drop-down arrow, or type your SQL Server Instance 

in the textbox.

Step 5: 	 Type in your sa password. Click Next.

If you do not know your sa password, see the section RESETTING  

YOUR MICROSOFT SQL SERVER sa PASSWORD, on page 40 of this  

document.

Step 6: 	� The Migrate 2008 SOS School Database screen displays.   

At this point, you are given an opportunity to migrate an  

existing database.  If you are not going to migrate an existing 

 database, continue on to Step 9.  Otherwise, click the Migrate 

checkbox.

Step 7: 	� Use the drop-down arrow, or type your SQL Server Instance  

in the textbox.  Type in your sa password.   

Click Next to migrate your existing database.  Proceed to  

Step 10.

Step 8: 	� If you are not migrating an existing database, click Next.
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  Step 9: 	� The Setup Admin Account screen displays. Type your  

Admin password and confirm your Admin password  

in the textboxes provided.  

Step 10: 	 Click Next.  

Step 11: 	� The Ready to Install the Program screen displays. 

Click Install.  

Step 14: 	� The AOP Setup Wizard Completed screen displays  

after all of your files are copied. Click Finish. Your  

local database is successfully installed. 
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Copy Curriculum Files

In an earlier step, you created a Shared Curriculum Folder on the server. In this step, you copy the curriculum files from the 
external hard drive to the Shared Curriculum Folder location.

Step 1:	 Connect the external USB curriculum hard drive to an available USB connecter on the server.

Step 2:	 Plug the external USB drive into power and make sure the drive is turned on.

Step 3:	� The server should automatically sense that the external drive has been connected. If this does not occur, consult 

the server’s setup manual for troubleshooting options.

Step 4:	 When the drive is connected and operating, open My Computer.

Step 5:	 Double-click the external USB drive to open it.

Step 6:	 Double-click the subjects08 folder to open it.

Step 7:	 Click Edit, and then click Select All to highlight all of the folders within the subjects08 folder.

Step 8:	 Locate the Shared Curriculum Folder that was created in the earlier step (\\server_name\c:\subjects08).

Step 9:	� Right-click the subjects08 folder and select Paste. Copying of files to the shared folder location begins. (The copy 

operation takes several hours or perhaps longer, depending on the type of USB port your server has.)

Client Computer Setup

Option 1:  Client Installation over the Network

The most convenient way to install the SOS Student application is to perform the  installation over the network to each client 

computer.  The following steps outline this type of installation.

Steps 1 through 18 below are performed on your network server.

Step 1: 	 Prepare a Shared Folder on the Server.  Open My Computer.

Step 2: 	 Open Local Disk (C:).

Step 3: 	 Click File, New, Folder.

Step 4: 	 Name the folder something like SOS_2008_Install.

Step 5: 	 Right-click the new folder and select Sharing and Security.

Step 6: 	 Click the option Share this folder.

Step 7: 	 Click Permissions.

Step 8: 	 Click Remove to remove the Everyone Group.

Step 9: 	 Click Add and add the Administrators Group to Share Permissions.
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Step 10: 	 Click Full Control under Permissions.

Step 11: 	 Click Apply and OK.

Step 12: 	 Click Apply and OK.

Step 13: 	� Insert the SOS 2008 Installation disc into the drive.  When the SOS 2008 Setup window appears, click Close.

Step 14: 	 Open My Computer.  Locate and right-click the SOS 2008 Installation disc and select Explore.

Step 15: 	 From the Edit menu, click Select All.

Step 16: 	 From the Edit menu, click Copy.

Step 17: 	 Locate the folder created in Step 4.

Step 18: 	� Right-click the folder and select Paste.  This copyies the contents of the SOS 2008 Installation disc to the shared 

folder.

Steps 19 through 25 below are performed on each client computer where you wish to install the SOS 

applications.

Step 19: 	 Log on to the client computer using an administrator account.

Step 20: 	 Open My Computer.  In the address bar, type the URL for the Server (\\server_name) and click Go.

Step 21: 	� The shared folder created in Step 4 should be visible.  If not, you need to check the sharing of the folder on the 

server.

Step 22: 	 Open the shared folder and locate the installation file MainSetup.exe.

Step 23: 	 Double-click MainSetup.exe to begin the SOS application installation.

Step 24: 	� See the section, SOS 2008 Setup:  Admin, Teacher, & Student, for detailed application setup steps.  You most 

likely need to install only Teacher or Student on each computer.

Step 25: 	 Repeat as many times as necessary to install the SOS application on each client computer.

Option 2:  Client Installation from Disc

Step 1: 	� Insert the SOS 2008 Installation disc into the client computer.  The SOS 2008 Setup window appears.  Follow 

the steps outlined in the section, SOS 2008 Setup:  Admin, Teacher, & Student, beginning on page 25 of this 

reference guide.

Step 2: 	 Repeat as many times as necessary to install the SOS application on each client computer.
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Removing (Uninstalling) Switched-On Schoolhouse® 2008 School Edition 

	 WARNING:    �It is critical when removing (uninstalling) the 2008 version of SOS you follow the steps below exactly as  
written.

	 1.	 Open Add/Remove Programs in the Control Panel.

	 2.	 Remove Switched-On Schoolhouse 2008 – School Edition.

	 3.	 Remove Switched-On Schoolhouse 2008 - School Edition Database.

	 4.	 Remove Microsoft SQL Server 2005.

	 5.	� On the Uninstall dialog window, select the instance of SOSSCHOOL30 and Workstation Components, and 

then click Next. 

	 XP USERS: Continue with Step 6 below.

	 ATTENTION: Vista Users:  

At this point in the uninstall process, you will see a dialog box similar to the one below. Click the Ignore button to proceed 

with your uninstall. Do not click Retry or press your Enter key. You will just continue to loop back to this dialog box.

 

	 6.	 Click Finish to proceed with the removal process.

	 7.	� Once the SQL Server 2005 uninstall is finished, four SQL components remain in your installed programs list. 

Remove Microsoft SQL Server Native Client next.

	 8.	� Remove Microsoft SQL Server Setup Support Files. When the warning box appears telling you “This action 

is only valid for products that are currently installed”, click OK.

	 9.	 Click View > Refresh on the Add/Remove Programs 

	 10.	 Repeat Step 7 for Microsoft SQL Server VSS Writer and MSXML 6.0 Parser, if necessary. 

You MUST remove Microsoft SQL Server 2005 before any of its components are removed or it will not 

be properly uninstalled and any subsequent installation attempts will fail. If you try to uninstall one of 

the components first, you will get a warning that the server should be removed first.
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Troubleshooting 

If you experience problems with the install, try the following before calling Technical Support:

q 	 Reboot your computer.

q 	 Close any open applications.

q 	 Disable/turn off any anti-virus software.

q 	 Repeat the installation process a second time.

q 	 �Verify that you have the most recent application and curriculum updates by visiting 

www.aopschools.com and clicking Tech Support. 

q 	 �Visit www.aopschools.com for detailed solutions to software Frequently Asked 

Questions (FAQs).

Curriculum Installation Errors

If you experience problems installing SOS 2008 curriculum, verify that you have successfully upgraded your current  

application to Switched-On Schoolhouse® 2008 School Edition.

Before You Call Technical Support

If you need to contact a Technical Support team member, gather the following information before placing your call:

q 	 Determine which version of Windows you are currently using.

q 	 Determine how much RAM and available disk space you have.

q 	 �Determine which version of Switched-On Schoolhouse® 2008 School Edition you are 

using.

To determine which version you are using, click the Schoolhouse logo located on your Home screen. 
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